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Basics 
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1-1 System 
You need: 

 A Windows Computer with WINDOWS 7, VISTA or XP. 

 
 

 The Control-Center. If you didn’t install the Control-Center, please installier it now. 

Then come back and go on with the next point.  

 
Control-Center Manual  

Control-Center Download 

 An active internet connection during the installation. 

 

 

  

http://www.easy-sports-software.com/hilfe/cc/hilfe_control_center_en.pdf
http://www.controlcenter.easy-test-designer.com/DOWNLOADS/Setups/ControlCenter-en.exe
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1-2 Installation  
1 – Start the Control-Center:  

 

2 – The easy Animation 3.0 the button is blue if you have a license for this software. You may 

click on the small arrow on the right of the button for a fast start or on the big left sid of the 

button to get to the info screen.  

 

In the info screen of easy Animation Version 3.0 click „Start“ to install the software (if you 

already installed the software, it will start). 

 

3 – Allow the User Account Control to install the software. 
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4 – Accept the license agreement.  

 

5 – Your software is being installed on your computer. 

 

6 – After installation the software starts automatically.  
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1-3 Starting easy Animation 3.0 
1 – Doubleclick on the Control-Center icon on your desktop. 

 

2 – To fast start easy Animation 3.0 click on the tiny arrow on the right side of the button.  
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1-4 De-Installation  
1 – Doubleclick on the Control-Center icon on your desktop. 

 

2 – Click on the left side of the button.  

 

3 – Click on „“ in the info window of easy Animation 3.0.  

 

 

  



 8 Manual easy Animation 3.0, © easy Sports-Software 

 

 

2 
Functions 
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2-1 Screen 

 
easy Animation screen, sports: soccer  

 

Tool-Tips 

When rolling with your mouse over the buttons you will see the tool tips. 
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2-2 Sports 
easy Animation 3.0 contains fields and tools for 

6 sports: Soccer, Handball, Volleyball, 

Basketball, Hockey and Ice Hockey.  

Tip: You may use any field, player or tool of every sports, 

e.g. a handball field for a soccer exercise.  

 

 

2-3 Fields 
Select a field by clicking on it. 

If the Players/Tools toolbox is activatec, click on „Fields“. 
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Turning Fields  

You may turn fields in steps of 90° to the left or to the right to see your sceen from a 

different perspective.  

 
Soccer field, initial position 

 
Soccer field after 90° turn to the right 
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Parts of a Field 

Select parts of a field with the magnifying glasses and the hand-button. Use the magnifying 

glass with the + to view details. Move the field with the hand-button.  

 
Soccer field 04 after using the + magnifying glass and the hand-button  
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2-4 Players / Tools 

Drag a Player / Tool onto the field 

Drag a plager or a tool with pressed left mouse button 

onto the field.   

If the fields toolbox is activated, click on „Players / Tools“. 

 

 
 

Select Players / Tools  

 

To select a single plaer or tool just click on it. Selected players are surrounded by a half circle 

and a turning point.  

Select a group of players or tools by rolling your mouse with the left tap pressed over the 

players and tools.  
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Moving Players / Tools  

Click on Player /Tools and drag it with the left mouse tap pressed to the position 

desired.  

 

Delete Players / Tools  

Either select Players/Tools and press DEL on your keyboard. 

 

Or select Players/Tools and select „Delete“ in the context menu, that you get when you click 

your right mouse tap.  

 

Or select Players/Tools and select „Delete“ in the Edit menu. 
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The Grid  

The grid helps you to position players and tools exactly.  

 

 

Turning Players  

Select a player/tool and move the yellow turning point.  

 

Scaling Players / Tools  

Select a player/tool and press the +cone or -cone until the player/tool reaches the correct 

size. The next player/tool that you drag onto the field automatically gets the size you gave to 

the last player/tool.  
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Lock Players / Tools  

Either: Select player/tools, open the context menu with the right tap of your mouse and 

select „Lock“. 

 

Or: Select player/tools and then select „Lock“ in the Edit menu.  

 

Why lock a player or a tool? You normally want a cone to remain at one fixed point of the field. If you want to 

move a group of players standing around a cone, the cone will also be moved. If you lock the cone it remains at 

the position you locked it.  
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Move players or tools forwards or backwards  

Either: Select the player or tool you want to move, then open the context menu by clicking 

the right mouse tap and select „Move forewards“ or „ Move backwards“. 

   

Oder: Select the player or tool you want to move, then click on „Move forewards“ or „ Move 

backwards” in the Edit menu. 

 

 

Text at a Player / Tool  

 

Select the player or tool and open the context menu with the right tap of your mouse. Click 

into the text field and write.  

To delete a text, delete all characters out of the textfield.  

Under the textfield you can make the text larger, smaller or color it.   
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Problems 

I cannot select a Player / Tool! 

Click on the Select tool button to solve the problem. 

 

 

  



 19 Manual easy Animation 3.0, © easy Sports-Software 

2-5 Create and play an animation 

The Starting position 

Creating an animation best works like this: Imagine how your animation looks in the very 

first moment. Drag all players and tools to their position.   
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Where are your Players/Tools at the end of the next second? 

After you created the starting position, click onto the yellow block in the time line „1. 

second”. You added one second to your animation. The second, on which you work is 

medium blue.  

Now imagine, where your players and the ball will be at the end of that 1. second. Drag them 

to their positions.  

 
At the end of the 1. second the players have reached the cones. 
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Where are the Players and Tools after one second more? 

Again click onto the yellow block in the time line to get the next second. Now again imagine, 

where your players and the ball will be at the end of that 2. second and drag them to their 

positions. 

It is always the same: You click onto the yellow block in the time line, drag the players and tools to the 

position that they take at the end of that second, click again onto the yellow block …  

 
At the end of the 2. second the players have turnd around themselves.   
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Play an animation  

Click onto the play button at the corner of the field. If there are a lot of seconds in your 

animation, you also may click onto any of the seconds and then click on play. The animation 

will start with the selected (blue) second.   

 

The time line while playing  

While an animation is being played, the timeline gets red.   

 

Moving the timeline with the mouse 

You may view the animation by rolling with your mouse, the left mous tap clicked, over the 

timeline.  

If the time line is wider that the screen  

Just move your mouse over last second you see, either on the right or on the left side of the 

software. The timeline will move and you will see the „hidden“ seconds again. 
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2-6 Save and Export an Animation 

Save an animation  

The save commands are in the File menu.  

 

When you save an animation the first time, the „Save as …“ dialogue shows up. If necessary 

choose a place on your computer where to save the animation and enter a file name. Finally 

click „Save“. 

 
„Save as…“ dialogue on a Windows 7 PC.  
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Save 

When you have saved an animation, you see 

the file name in the title line of the software.  

 

If you changed your animation you will see a 

tiny star „*“ behind the file name. 

 

Select „Save“ to save changes in an already saved file.   

 

 

 

Save as…  

If you want to save an already saved file under a different file name, select „Save as…” in the 

File menu.   
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Export an animation  

There are two export formats: AVI and FLV (Flash Video). 

 

The Export Window 

Select frame rate, video quality and video size in the export window. The exported videos 

may be up to 1491 x 1066 px.. 
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Save a second as a picture  

You may save a second as a picture in the png-format. There are two ways to do that: 

1 – Click with your right mouse tap at any free place on a field. Click on „Save scene as 

picture“. Enter a file name in the Save file dialogue.  

 

2 – Click on the Screenshot button. Enter a file name in the Save file dialogue. 

  

 

2-7 Change an animation  

Changing a second 

Click on the second you want to change an do the changes. You may delete, add, move, turn 

…  

 

  



 27 Manual easy Animation 3.0, © easy Sports-Software 

Add a second at the end of an animation  

Click on the yellow block in the time line.  

 

Add a second at any place / duplicate a second  

Click on the second. Move the mouse over the selected second and lick on the Duplicate 

button. Result: The 7th second will be duplicated and shows up behind the 7th second.  

 

  



 28 Manual easy Animation 3.0, © easy Sports-Software 

Delete a second 

Click on the second you want to delete, more your mouse over it and click on the cross on 

the red circle. 

 

Delete a selection of seconds at once 

Click on the first second you want to delete. Press SHIFT and click on the last second you 

want to delete. All blue seconds will be deleted at once when you click on the cross on the 

red dot on the last selected second. 

 

 

Scene text 

You may add a scene text to every single second. Click on the second and then click on the 

small T.  
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Enter your text into the textfield. At the end click OK.  

 

Select a couple of seconds to give the selection the same scene text.   

 
 

The scene text shows up during the animation at the bottom of the field.   
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Speed of an animation 

There are two buttons at the left end of the time line. Click onto the upper button to make 

the animation slowlier.  

 

 

Showing running lines  

If you click ont the Running lines button, you the running lines will be shown with coloured 

lines.  
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3 The Drawing Tool 

The Button „Drawing Tool“ 

Circles, rectangulas, lines and arrows let you mark special parts or actions of a game 

situation.  

The buttons has two parts. In the upper part you see the last selected object. When you click 

on the small arrow, the drawing menu opens up.  

The Drawing Tool/Marking Tool 

Click on the drawing objects on the left: line, arrow, rectangle, circle.  

Choose the line thickness in the middle.  

Select the colour on the right.  

Click „OK“ to close the menu and begin to draw ond the field. 
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Insert a Drawing Object 

Click on the second or select a selection of seconds on which you want a drawing object to 

appear.  

Click on the small arrow of the Drawing Tool button to open the Drawing Tool, select e.g. a 

rectangle. If you want select a different thickness for the borders. Click OK and draw the 

ractangle at the place desired on the field.  

Move a Drawing Object  

Click with your mouse on the object you want to move and drag it with your mouse.  

Delete a Drawing Object 

Click with your mouse on the object you want to delete and delete it with the 

DEL key on the keyboard.  
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